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NEW QUESTION 1

Refer to the exhibit. Users report that when they dial to Cisco Unity Connection from an external network, they cannot enter any digits. Assuming only in-band
DTMF is supported, what is a reason for this malfunction?

A. The negotiated RTP port is outside of the range described by RFC, so inband DTMFs do not work.
B. There is SIP Delayed Offe
C. DTMF is supported only in Early Offer.
D. The rtpmap:0 value for the negotiated codec is marking DTMF as inactive.
E. No DTMF is negotiated.

Answer: D

NEW QUESTION 2
The administrator of ABC company is troubleshooting a one-way audio issue for a call that uses H.323 protocol (slow-start mode). The administrator requests that
you provide the IP and port information of the Real-Time Transport Protocol traffic that had the one-way audio call.
You gather the H.225 and H.245 messages for one of the one-way audio calls. Where can you find the RTP IP and port information for both sides? (Note: This call
flow has not invoked any media resources like MTP or transcoders).

A. H.245 Terminal Capability Set
B. H.245 Open Logical Channel
C. H.225 Connect
D. H.245 Open Logical Channel Ack

Answer: B

NEW QUESTION 3
When you troubleshoot H.323 call setup, which message informs you that the called party is being notified about the call?

A. ALERTING
B. PROCEEDING
C. CONNECT
D. RINGING

Answer: C

NEW QUESTION 4
An administrator is troubleshooting call failures on an H.323 gateway via the CLI. To see signaling for media and call setup, which debug must the Administrator
turn on?

A. debug H.323 messages
B. debug H.225 asn1
C. debug H.246 asn 1
D. debug H.225 media
E. debug H.323 asn 1

Answer: B

NEW QUESTION 5
Cisco SIP IP telephony is implemented on two floors of your company. Afterward, users report intermittent voice issues in calls established between floors. All calls
are established, and sometimes they work well, but sometimes there is oneway audio or no audio. You determine that there is a firewall between the floors, and
the administrator reports that it is allowing SIP signaling and UDP ports from 20000 to 22000 bidirectionally. What are two possible solutions? (Choose two.)
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A. Go to the SIP profile assigned to these IP phones in Cisco Unified CM and change the range of media ports to 16384-32767
B. Ask the firewall administrator to change the ports to TCP.
C. Ask the firewall administrator to change the range of UDP ports to 16384-32767.
D. Go to the SIP profile assigned to these IP phones in Cisco Unified CM and change the range of media ports to 20000-22000.
E. Go to System Parameters in Cisco Unified Communications Manager and change the range of media ports to 20000-22000.

Answer: AC

NEW QUESTION 6
Which section under the Real-Time Monitoring Tool allows for reviewing the call flow and signaling for a SIP call in real time?

A. Analysis Manager > Inventory > Trace File Repositories
B. System > Tools > Trace and Log Central
C. Voice/Video > Session Trace Log View > Real Time Data
D. Voice/Video > Session Trace Log View > Open From Local Disk

Answer: C

NEW QUESTION 7
Which description of RTP timestamps or sequence numbers is true?

A. The sequence number is used to detect losses.
B. Timestamps increase by the time “carrying” by a packet.
C. Sequence numbers increase by four for each RTP packet transmitted.
D. The timestamp is used to place the incoming audio and video packets in the correct timing order (playout delay compensation).

Answer: D

NEW QUESTION 8
Which action is correct with respect to toll fraud prevention configuration in the Cisco Unified Communications Manager Express?

A. Configure Direct Inward Dial for Incoming ISDN Calls with overlap dialing.
B. Configure IP Address Trusted Authentication for Incoming VoIP Calls.
C. Configure the command no ip address trusted authenticate under “voice service voip”.
D. Enable Secondary Dial tone on Analog and Digital FXO Ports.

Answer: B

NEW QUESTION 9
You see the voice register pool 1 command in your Cisco Unified Communications Manager Express configuration. Which configuration is occurring in this
section?

A. configuration for a single SIP phone
B. configuration items common for all SIP phones
C. configuration for a pool of SIP phones (similar to device pool on Cisco Unified Communications Manager)
D. configuration for SIP registrar service

Answer: C

NEW QUESTION 10
Which top-level IOS command is needed to begin the configuration of a Cisco Unified Communications Manager Express gateway to enable phones to be
registered via SIP?

A. allow-connections sip to sip
B. voice service voip
C. voice register global
D. voice register dn

Answer: C

NEW QUESTION 10
Where is the dtmf-relay command configured on Cisco Unified Border Element?

A. in the voice-class VoIP configuration
B. in the VoIP dial peer
C. in global SIP configuration
D. in the VoIP or POTS dial peers

Answer: B

NEW QUESTION 13
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Refer to the exhibit. Users report that outbound PSTN calls from phones registered to Cisco Unified Communications Manager are not completing. The local
service provider in North America has a requirement to receive calls in 10-digit format. The Cisco Unified CM sends the calls to the Cisco Unified Border Element
router in a globalized E.164 format. There is an outbound dial peer on Cisco Unified Border Element configured to send the calls to the provider. The dial peer has
a voice translation profile applied in the correct direction but an incorrect voice translation rule applied, which is shown in the exhibit. Which rule modified DNIS in
the format that the provider is expecting?

A. rule 1 /^/+\([^1].*\)/ /011\1/
B. rule 1/^\+1\([2-9]..[2-9]……$\)/ /\1/
C. rule 1 /^\([2-9]..[2-9]……$\)/ /\1/
D. rule 1 /^\+1\([2-9]..[2-9]……$\)/ /\0/

Answer: B

NEW QUESTION 15
An engineer must route all SIP calls in the form of <user>@example.com to the SIP trunk gateway corporate local. Which two SIP route patterns can be used to
accomplish this task? (Choose two.)

A. example.com@gateway.corporate.local
B. *@example.com
C. gateway.corporate.local
D. example.com
E. *.*

Answer: BE

NEW QUESTION 19
Which two statements are correct with respect to the Client Matter Code setting in the route pattern configuration? (Choose two.)

A. The Client Matter Code feature does not support overlap sending because the Cisco Unified CM cannot determine when to prompt the user for the code.
B. If you check the Allow Overlap Sending check box, the Require Client Matter Code check box becomes disabled.
C. If you check the Allow Overlap Sending check box, you can also check the Require Client Matter Code check box.
D. The Client Matter Code feature does support overlap sending because the Cisco Unified Communications Manager can determine when to prompt the user for
the code.
E. The Client Matter Code has the option to configure Authorization Level such as in the Forced Authorization Code.

Answer: AB

NEW QUESTION 21
A network engineer designs a new dial plan and wants to block a certain range of numbers (8135100 through 8135105). What is the most specific route pattern
that can be configured to block only the numbers in this range?

A. 813510[012345]
B. 813510[12345]
C. 813510[^0-5]
D. 81XXXXX

Answer: A

NEW QUESTION 25
Refer to the exhibit. An engineer configures Cisco Unified Border Element to connect the enterprise VoIP network with a SIP telephony provider. Calls are not
working in either direction. What must be configured in the dial peer 1 to fix the issue?

A. address 555 ……..
B. codec g729
C. session-protocol sipv2
D. incoming called number 555…….

Answer: D

NEW QUESTION 29
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Refer to the exhibit. An administrator is troubleshooting a situation where a call placed from a phone registered to Cisco Unified Communications Manager does
not complete. The administrator wants to use the Dialed Number Analyzer on Cisco Unified CM to check which translation pattern the call is matching. However,
when logging in to Cisco Unified Serviceability there is no option for Dialed Number Analyzer under the tool menu. Which two steps must be performed to resolve
this issue? (Choose two.)

A. Restart the subscriber
B. Activate the Cisco Extended Functions service.
C. Activate the Cisco CallManager service.
D. Activate the Cisco Dialed Number Analyzer service.
E. Activate the Cisco Dialed Number Analyzer Server service.

Answer: DE

NEW QUESTION 31
In Cisco Unified Communications Manager globalized call routing is implemented and must confirm that it is correctly implemented without making a call. Which
tool do you use for verification?

A. Dialed Number Analyzer
B. Real-Time Monitoring Tool
C. SDI trace
D. SDL trace

Answer: A

NEW QUESTION 34
Where on Cisco Unified Communications Manager do you configure the standard local route group for a group of devices?

A. System > Location Info
B. Call Routing > Route/Hunt > Local Route Group Names
C. System > Device Pool
D. Call Routing > Emergency Location > Emergency Location (ELIN) Groups

Answer: B

NEW QUESTION 39
How does an engineer globalize routing for ingress calls coming from the PSTN to internal DNs?

A. At the PSTN gateway, put the calling number in PSTN format and the called number in DN format.
B. At Cisco Unified CM, put the calling number in E.164 format and the called number in PSTN format.
C. At the PSTN gateway, put the calling number in E.164 format and the called number in localized (DN) format.
D. At Cisco Unified Communications Manager, put the calling number in E.164 format and the called number in E.164 format.

Answer: B

NEW QUESTION 43
When locations-based Call Admission Control denies the call, which two masks can AAR apply when routing the call through the PSTN? (Choose two.)

A. AAR destination mask
B. called party transform mask
C. external phone number mask
D. +E.164 alternate number mask
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E. enterrise alternate number mask

Answer: AC

NEW QUESTION 45

Refer to the exhibit. How many maximum hops can an ILS updarte traverse?

A. 3
B. 6
C. 9
D. 12

Answer: A

NEW QUESTION 46
Which configuration element of a hunt group allows for changing Calling Party Transformations settings?

A. line group
B. hunt pilot
C. route group
D. hunt list

Answer: B

NEW QUESTION 49
Which two types of authentication are supported for the configuration of Intercluster Lookup Service? (Choose two.)

A. TokenID
B. username and secret key
C. TLS certificates
D. passwords
E. FQDN of the servers defined in DNS

Answer: CD

NEW QUESTION 53
What is the relationship between partition, time schedule, and time period in Time-of-Day routing in Cisco Unified Communications Manager?

A. A partition can have multiple time schedules assigne
B. A time schedule contains one or more time periods.
C. A partition can have one time schedule assigne
D. A time schedule contains one or more time periods.
E. A partition can have multiple time schedules assigne
F. A time schedule contains only one time period.
G. A partition can have one time schedule assigne
H. A time schedule contains only one time period.

Answer: A

NEW QUESTION 54
What is a component of Cisco Unified Mobility?

Passing Certification Exams Made Easy visit - https://www.2PassEasy.com



Welcome to download the Newest 2passeasy 300-815 dumps
https://www.2passeasy.com/dumps/300-815/ (118 New Questions)

A. Unified IVR
B. Mobile Connect
C. Smart Client Support
D. Single Number Connect

Answer: B

NEW QUESTION 56
When the services key is pressed Cisco Extension Mobility does not show up. What is the cause of the issue?

A. The URL configured for Cisco Extension Mobility is not correct.
B. Cisco Extension Mobility Service is not running.
C. The phone is not subscribed to Cisco Extension Mobility Service.
D. Cisco Extension Mobility is not enabled in the Phone Configuration Window (Device > Phone)

Answer: C

NEW QUESTION 61
A user reports when they press the services key they do not receive a user ID and password prompt to assign the phone extension. Which action resolves the
issue?

A. Create the default device profiles for all phone models that are used.
B. Subscribe the phone to the Cisco Extension Mobility service.
C. Create the end user and associate it to the device profile.
D. Assign the extension as a mobile extension.

Answer: B

NEW QUESTION 63
Which services are needed to successfully implement Cisco Extension Mobility in a standalone Cisco Unified Communications Manager server?

A. Cisco Extended Functions, Cisco Extension Mobility, and Cisco AXL Web Service
B. Cisco CallManager, Cisco TFTP, and Cisco CallManager SNMP Service
C. Cisco CallManager, Cisco TFTP, and Cisco Extension Mobility
D. Cisco TAPS Service, Cisco TFTP, and Cisco Extension Mobility

Answer: C

NEW QUESTION 64
......
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